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👋 Hello
me: Dr Anna Krystalli

Research Software Engineer, University of Shef�eld

twitter @annakrystalli
github @annakrystalli
email a.krystalli[at]shef�eld.ac.uk

Editor rOpenSci

Core Team: ReproHack

slides: bit.ly/r-in-repro-research-dc-ucl
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Motivation
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Calls for reproducibility
Reproducibility has the potential to serve as a
minimum standard for judging scienti�c claims when
full independent replication of a study is not
possible.

Reproducible Research in Computational Science ROGER D. PENG, SCIENCE 02 DEC 2011 : 1226-1227
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Is code and data enough?

slide: Karthik Ram: rstudio::conf 2019 talk
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R for Open Reproducible Research

A whistle-stop tour of tools, practices and
conventions in R for more:

Reproducible

Robust

Transparent

Reusable

Shareable research materials
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Project management

Icon by Freepik  from �aticon.com
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Self contained and portable
Working directory set to root of
project on launch
Fresh session everytime the project is
launched

See Jenny Bryan's post on project oriented
work�ows  for more details

File > New Project > New Directory

Rstudio Projects

Use Rstudio projects to keep materials associated
with a particular analysis together
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Robust paths relative to project root
portable
independent of:

working directory
source code location

📦 here

Use 📦 here  to create robust relative paths

here��here()

�� [1] "/Users/Anna/Documents/workflows/talks"

here��here("data", "summaries.csv")

�� [1] "/Users/Anna/Documents/workflows/talks/data/summaries.csv"

Icon by Freepik  from �aticon.com
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Most robust approach
use 📦 renv  (previously packrat )

Create and manage a per project
library of packages
intialise during project set up

Dependency management
Minimal approach
include an install.R  script

install.packages("dplyr")

install.packages("purrr")

will revisit later on
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📦 drake

Use 📦 drake  to orchestrate your work�ows

make plan

plan �� drake��drake_plan(

  raw_data = readr��read_csv(here��here("data", "iris.csv")),

  data = raw_data %>%

    dplyr��mutate(Species = forcats��fct_inorder(Species)),

  fit = lm(Sepal.Width ~ Petal.Width + Species, data))
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Plan
view plan

plan

�� # A tibble: 3 x 2

��   target   command                                                            

��   <chr>    <expr_lst>                                                         

�� 1 raw_data readr��read_csv(here��here("data", "iris.csv"))                    

�� 2 data     raw_data %>% dplyr��mutate(Species = forcats��fct_inorder(Species))

�� 3 fit      lm(Sepal.Width ~ Petal.Width + Species, data)

re-execute plan

drake��make(plan)

�� All targets are already up to date.
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inspect targets

drake��readd(fit)

�� 

�� Call:

�� lm(formula = Sepal.Width ~ Petal.Width + Species, data = data)

�� 

�� Coefficients:

��       (Intercept)        Petal.Width  Speciesversicolor   Speciesvirginica  

��             3.236              0.781             -1.501             -1.844
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visualise work�ow
drake��vis_drake_graph(drake��drake_config(plan))

Dependency graph
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Version Control
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Version Control
What is it? 🤔
The management of changes to documents, computer programs, large web sites, and other
collections of information.

Git 
Open source (free to use) Version control software.

GitHub 
A website ( https://github.com/ ) that allows you to store your Git repositories online and
makes it easy to collaborate with others.
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Exhibit A

Image: xkcd CC BY-NC 2.5

Exhibit B

Image: Jorge Cham www.phdcomics.com

Why use them in research?
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Git, Github & Rstudio
Before: git only through the terminal 😢

Now: Rstudio + usethis  📦 == ❤  Git  & GitHub  🤩
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Con�gure git & GitHub
Con�gure git
Check your con�guration

usethis��git_sitrep()

Set your con�guration

Use your github username and and the email you used to sign-up on GitHub

usethis��use_git_config(

    user.name = "Jane",

    user.email = "jane@example.org")
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Con�gure GitHub authentication
Get GITHUB Personal Authorisation Token
usethis��browse_github_pat()
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Store in .Renviron  �le
usethis��edit_r_environ()
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Initialise git
Initialise Rstudio project with Git by just checking a box!
It's now a repository

Forgot to? use usethis��use_git()
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Git panel

Integrated graphical user interface
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view �le status

stage �les

commit changes

Git Rstudio work�ow
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Share on GitHub
Create repo

usethis��use_github(protocol = "https")

Push further changes
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Anatomy of a GitHub Repo
README . Explain what your project is, and how to use it.

usethis��use_readme_md()

usethis��use_readme_rmd()

LICENSE . Without a licence, the contents of the repository are technically closed.

Examples licence MIT : usethis��use_mit_license(name = "Anna Krystalli")
?licenses : details of functions available to generate licenses
https://choosealicense.com/  help on choosing a licence.

CONTRIBUTING.md  - guidelines for contributors.

usethis��use_tidy_contributing()  provides a realtively strict but instructive
template

CODE_OF_CONDUCT.md  set the tone for discourse between contributors.

use_code_of_conduct()
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issues projects

GitHub issues
use GitHub issues to plan, record and discuss tasks.
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Literate programming with Rmarkdown
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Literate programming
Programming paradigm �rst introduced by Donald E. Knuth.

Treat program as literature to be understandable to
human beings

focus on the logic and �ow of human thought and understanding
single document to integrate data analysis (executable code) with textual
documentation, linking data, code, and text
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Literate programming in R
Rmarkdown (.Rmd ) integrates:

a documentantion language ( .md )

a programming language ( R )

functionality to "knit" them together through 📦 knitr

features
✅ provides a framework for writing narratives around code and data

✅ Code re-run in a clean environment every time the document is "knit"
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Rmarkdown outputs
This image was created by Scriberia for The Turing Way community and is used under a CC-BY licence.
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Rmarkdown to html
File > New File > RMarkdown... > Document
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Documentation of code & data (eg 📦
DataMaid )
Electronic Notebooks
Supplementary materials
Reports
Papers

Applications in research
Rmd documents can be useful for a number of research
related long form documentation  materials:
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RPubs: Publish rendered rmarkdown
documents on the web with the click
of a button http://rpubs.com/

GitHub: Host your site through gh�

pages  on GitHub. Enable in GitHub
repo ⚙ Settings

Netlify: Connect a repository, build
your site, deploy and host for free.
https://www.netlify.com/

Publish to the web for free!
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Rmarkdown extensions
Many great packages and applications build on rmarkdown.

All this makes it incredibly versatile .
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bookdown
Create and mantain online books

Authoring with R Markdown. Offers:

cross-references,
citations,
HTML widgets and Shiny apps,
tables of content and section numbering

The publication can be exported to HTML, PDF, and e-books (e.g. EPUB)

Examples
rOpenSci Software Review policies
Geocomputation in R

Thesisdown
An updated R Markdown thesis template using the bookdown package
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pkgdown
For buidling package documentation

Produce function references from .Rd  �les and demonstrate function use through long
form documentation (vignettes).
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work�owr pkg
Build analyses websites and organise your project

Makes it easier for researchers to organize projects and share results. Includes checks to
ensure rendered versions correspond to up to date versions of code.
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blogdown

For creating and mantaining blogs through R.
Check out https://awesome-blogdown.com/ , a curated list of awesome #rstats blogs in
blogdown for inspiration!
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presentations

A number of existing frameworks

xaringan  📦 Presentation Ninja 幻灯忍者 · 写轮眼
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Managing code
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When a project is new and shiny, an
analysis script usually contains many
lines of directly executated code.

As it matures, reusable chunks get
pulled into their own functions.

The actual analysis scripts then
become relatively short, and functions
de�ned in separate R scripts.

Managing analysis code

Separate function de�nition and application
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R Package Structure

Used to share functionality with the R community
Useful conventions

Useful software development tools

Easy publishing through GitHub
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Build panel

Integrated graphical user interface
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R Package conventions:
metadata: in the DESCRIPTION  �le

functions in .R  scripts in the R/  folder

tests in the tests/  folder

Documentation:

functions using Roxygen notation
work�ows using .Rmd  documents in the vignettes/  folder
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DESCRIPTION  �le
Package metadata
Package: gaitr

Type: Package

Title: Functions to support BMC gait analysis

Description: Helpers to analyse processed gait data.

Version: 0.0.9000

Authors@R� 

    c(person(given = "Anna",

             family = "Krystalli",

             role = c("aut", "cre"),

             email = "annakrystalli@googlemail.com"),

      person(given = "Lorenza",

             family = "Angelini",

             role = "aut",

             email = "l.angelini@sheffield.ac.uk"))

License: MIT + file LICENSE
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citation
citation("gaitr")

�� 

�� To cite package 'gaitr' in publications use:

�� 

��   Anna Krystalli and Lorenza Angelini (2019). gaitr: Functions to

��   support BMC gait analysis. R package version 0.1.1.

��   https:��github.com/annakrystalli/gaitr

�� 

�� A BibTeX entry for LaTeX users is

�� 

��   @Manual{,

��     title = {gaitr: Functions to support BMC gait analysis},

��     author = {Anna Krystalli and Lorenza Angelini},

��     year = {2019},

��     note = {R package version 0.1.1},

��     url = {https:��github.com/annakrystalli/gaitr},

��   }
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Dependency management
It’s the job of the DESCRIPTION  �le to list the packages that your code depends on.

Imports: 

    dplyr,

    purrr,

    here,

    broom,

    tibble,

    magrittr,

    janitor,

    ggplot2

Suggests: 

    knitr,

    rmarkdown

add dependency

usethis��use_package("forcats", type = "Imports")
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Functions in R/
example function script
Create a new function .R  �le in the R/  folder

usethis��use_r("add")

R

└── add.R

0 directories, 1 files
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Document functions with Roxygen
Create help �les on build (autogenerated .Rd  �les in man/ )
Specify which functions are exported (autogenerated NAMESPACE )

#' Add together two numbers.

#' 

#' @param x A number.

#' @param y A number.

#' @return The sum of x and y.

#' @examples

#' add(1, 1)

#' add(10, 1)

add �� function(x, y) {

  x + y

}
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tests

Tests provide con�dence in what the code is doing.
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Example test
usethis��use_test("add")

Creates a tests/  folder with the following �les

tests

├── testthat

│   ├── test�add.R

└── testthat.R

test-add.R

context("test�add")

test_that("add works", {

  expect_equal(add(2, 2), 4)

})
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Monitor the effect of changes to the
code
Safe onboarding of contributions

Start with a .travis.yml  �le
usethis��use_travis()

 
 

Continuous Integration w/ Travis

A cloud testing framework for automating your tests
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.travis.yml

Resulting .travis.yml  �le template
language: R

sudo: false

cache: packages

instructions to enable TRAVIS CI
✔ Writing '.travis.yml'
✔ Adding '^��.travis��.yml$' to '.Rbuildignore'
● Turn on travis for your repo at https:��travis�ci.org/profile/annakrystalli

● Copy and paste the following lines into '/Users/Anna/Documents/workflows/talks/README.md

  [![Travis build status](https:��travis�ci.org/annakrystalli/talks.svg?branch=master)](htt
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Continuous Integration w/ GitHub
Actions
You can now run Continuous Integration on GitHub! See Jim Hester's rstudio conf 2020 talk
on Azure Pipelines and GitHub Actions

usethis��use_github_action_check_release() : installs the latest release R version on
macOS and runs R CMD check  via the rcmdcheck package.
usethis��use_github_action_check_standard() : runs R CMD check  on the three major
OSs (linux, macOS and Windows) on the release version of R and R-devel.
usethis��use_github_action_check_full() : installs the last 5 minor R versions and
runs R CMD check  on the three major OSs (linux, macOS and Windows).

All github actions added to .github/workflows  directory of a package.
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Tips on Tests and CI
Use other R package tests & CI con�gurations as inspiration

Look in tests/  for ideas on suitable tests.

Look at CI con�guration �les (eg travis.yml  or �les in .github/workflows ) to set up
testing environment.
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Research compendia
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A Research compendium
The paper is the advertisement

“an article about computational result is advertising, not scholarship. The actual
scholarship is the full software environment, code and data, that produced the
result.”

John Claerbout paraphrased in Buckheit and Donoho (1995)

The concept of a Research Compendium
“ ...We introduce the concept of a compendium as both a container for the
different elements that make up the document and its computations (i.e. text,
code, data, ...), and as a means for distributing, managing and updating the
collection."

Gentleman and Temple Lang, 2004
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Research compendia in R
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Paper:

Boettiger, C. (2018) From noise to knowledge: how
randomness generates novel phenomena and
reveals information.
https://doi.org/10.1111/ele.13085

Compendium

cboettig/noise-phenomena: Supplement to: "From
noise to knowledge: how randomness generates
novel phenomena and reveals information"
http://doi.org/10.5281/zenodo.1219780

Example compendium
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rrtools : Creating Compendia in R
"The goal of rrtools is to provide instructions, templates,
and functions for making a basic compendium suitable for
writing reproducible research with R."

Install rrtools  from GitHub
# install.packages("devtools")

devtools��install_github("benmarwick/rrtools")
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Create compendium
rrtools��create_compendium("~/Documents/workflows/rrcompendium")

✔ Setting active project to '/Users/Anna/Documents/workflows/rrcompendium'
✔ Creating 'R/'
✔ Creating 'man/'
✔ Writing 'DESCRIPTION'
✔ Writing 'NAMESPACE'
✔ Writing 'rrcompendium.Rproj'
✔ Adding '.Rproj.user' to '.gitignore'
✔ Adding '^rrcompendium��.Rproj$', '^��.Rproj��.user$' to '.Rbuildignore'
✔ Opening new project 'rrcompendium' in RStudio
✔ The package rrcompendium has been created
✔ Opening the new compendium in a new RStudio session���
Next, you need to:  ↓ ↓ ↓ 

● Edit the DESCRIPTION file

● Use other 'rrtools' functions to add components to the compendium
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✔ Creating 'README.Rmd' from template.
✔ Adding 'README.Rmd' to `.Rbuildignore`.
● Modify 'README.Rmd'

✔ Rendering README.Rmd to README.md for GitHub.
✔ Adding code of conduct.
✔ Creating 'CONDUCT.md' from template.
✔ Adding 'CONDUCT.md' to `.Rbuildignore`.
✔ Adding instructions to contributors.
✔ Creating 'CONTRIBUTING.md' from template.
✔ Adding 'CONTRIBUTING.md' to `.Rbuildignore`.

Prepare for GitHub
rrtools��use_readme_rmd()
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Create analysis folder
rrtools��use_analysis()

✔ Adding bookdown to Imports
✔ Creating 'analysis' directory and contents
✔ Creating 'analysis'
✔ Creating 'analysis/paper'
✔ Creating 'analysis/figures'
✔ Creating 'analysis/templates'
✔ Creating 'analysis/data'
✔ Creating 'analysis/data/raw_data'
✔ Creating 'analysis/data/derived_data'
✔ Creating 'references.bib' from template.
✔ Creating 'paper.Rmd' from template.
Next, you need to:  ↓ ↓ ↓ ↓ 

● Write your article/report/thesis, start at the paper.Rmd file

● Add the citation style library file (csl) to replace the default provided here, see https

● Add bibliographic details of cited items to the 'references.bib' file

● For adding captions & cross�referencing in an Rmd, see https:��bookdown.org/yihui/bookdow

● For adding citations & reference lists in an Rmd, see http:��rmarkdown.rstudio.com/author
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Rmd pdf

paper.Rmd  to paper.pdf

UCL Tech Social                             @annakrystalli  @annakrystalli 
66 / 113

https://twitter.com/annakrystalli
https://github.com/annakrystalli


Capturing dependencies
rrtools��add_dependencies_to_description()

Imports: 

    bookdown,

    ggplot2 (�� 3.0.0),

    ggthemes (�� 3.5.0),

    here (�� 0.1),

    knitr (�� 1.20),

    rticles (�� 0.6)
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Further Helpers

📦 rticles
Contains a suite of custom R Markdown templates for popular journals, simplifying the
creation of documents that conform to research paper submission standards.
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📦 citr
RStudio Add-in to Insert Markdown Citations
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Reproducible Computational
Environments
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slide: Karthik Ram: rstudio::conf 2019 talk

Why isn't sharing code enough?
Case Study: Sharing a Geospatial Analysis in R

On a computer without System Library GDAL  ❌

package ‘rgdal’ successfully unpacked 

and MD5 sums checked

configure: gdal�config: gdal�config

checking gdal�config usability��� ./conf

line 1353: gdal�config: command not foun

no

Error: gdal�config not found

���

ERROR� configuration failed for 

package ‘rgdal’
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What are Docker containers?

standardized units of software
package up everything needed to run an application: code, runtime, system tools, system
libraries and settings in a lightweight, standalone, executable package

Docker�le: Text �le containing recipe for setting up computation environment.

Docker Image: Executable built from the Docker�le with all required dependencies
installed. Can have many images from the same Dockerfile .

Docker Container: Docker Images become containers at runtime
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slide: Karthik Ram: rstudio::conf 2019 talk

Rocker on DockerHub
using the rocker/geospatial  Docker Image ✅
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Create Docker�le w/ rrtools
rrtools��use_dockerfile()

✔ Creating 'Dockerfile' from template.
✔ Adding 'Dockerfile' to `.Rbuildignore`.
● Modify 

Next: 

 * Edit the dockerfile with your name & email

 * Edit the dockerfile to include system dependencies, such as linux libraries that ar

 * Check the last line of the dockerfile to specify which Rmd should be rendered in th
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Dockerfile

# get the base image, the rocker/verse has R, RStudio and pandoc

FROM rocker/verse:3.6.0

# required

MAINTAINER Anna Krystalli <annakrystallil@googlemail.com>

COPY . /rrcompendiumDTB

# go into the repo directory

RUN . /etc/environment \

  # Install linux depedendencies here

  # e.g. need this for ggforce��geom_sina

  �� sudo apt�get update \

  �� sudo apt�get install libudunits2-dev �y \

  # build this compendium package

  �� R �e "devtools��install('/rrcompendiumDTB', dep=TRUE)" \

  # render the manuscript into a docx, you'll need to edit this if you've

  # customised the location and name of your main Rmd file

  �� R �e "rmarkdown��render('/rrcompendiumDTB/analysis/paper/paper.Rmd')"
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Docker + Travis

Create .travis.yml
rrtools��use_travis()

✔ Creating '.travis.yml' from template.
✔ Adding '.travis.yml' to `.Rbuildignore`.
Next: 

 * Add a travis shield to your README.Rmd:

[![Travis-CI Build Status](https:��travis�ci.org/annakrystalli/rrcompendiumDTB.svg?bra

 * Turn on travis for your repo at https:��travis�ci.org/annakrystalli/rrcompendiumDTB

* To connect Docker, go to https:��travis�ci.org/, and add your environment 

variables: DOCKER_EMAIL, DOCKER_USER, DOCKER_PASS to enable pushing to the 

Docker Hub
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.travis.yml

env:

  global:

  - REPO=$DOCKER_USER/rrcompendiumdtb

sudo: required

warnings_are_errors: false

language: generic

services:

  - docker

before_install:

  - docker build �t $REPO .

Create & build image using docker�le, i.e. compile pkg and render Rmd to Word doc

UCL Tech Social                             @annakrystalli  @annakrystalli 
77 / 113

https://twitter.com/annakrystalli
https://github.com/annakrystalli


.travis.yml

Push our custom docker image to docker hub, env vars stored on travis-ci.org

Travis repository settings

after_success:

  - docker login �u $DOCKER_USER �p $DOCKER_PASS

  - export REPO=$DOCKER_USER/rrcompendiumdtb

  - export TAG=`if [ "$TRAVIS_BRANCH" �� "master" ]; then echo "latest"; else echo $TR

  - docker build �f Dockerfile �t $REPO:$COMMIT .

  - docker tag $REPO:$COMMIT $REPO:$TAG

  - docker tag $REPO:$COMMIT $REPO:travis�$TRAVIS_BUILD_NUMBER

  - docker push $REPO
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Travis build passes!

buildbuild passingpassing
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Image on Dockerhub

Docker Image: https://hub.docker.com/repository/docker/akrystalli/rrcompendiumdtb

Compendium Repository: https://github.com/annakrystalli/rrcompendiumDTB
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Working with the Docker Image
Pull it from Dockerhub.

docker pull akrystalli/rrcompendiumdtb:latest

Run in Rstudio in your browser

More on using the RStudio image

docker container run �e PASSWORD��password> �e USERID=$UID �p 

8787�8787 ��detach ��name rrcompendiumdtb

akrystalli/rrcompendiumdtb:latest
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Binder
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What is binder? https://mybinder.org/
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Binderhub Ecosystem
This image was created by Scriberia for The Turing Way community and is used under a CC-BY licence.
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Binder for R
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R repository options for Binder
slide: Karthik Ram: rstudio::conf 2019 talk
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Binderise your R projects w/ holepunch
https://github.com/karthik/holepunch
remotes��install_github("karthik/holepunch")

Create .binder/Dockerfile

holepunch��write_dockerfile(maintainer = "Anna Krystalli")

→ Setting R version to 3.6.0

→ Locking packages down at 2019-11-09

✔ Dockerfile generated at ./.binder/Dockerfile
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.binder/Dockerfile

FROM rocker/binder:3.6.0

LABEL maintainer='Anna Krystalli'

USER root

COPY . ${HOME}

RUN chown -R ${NB_USER} ${HOME}

USER ${NB_USER}

RUN wget https:��github.com/annakrystalli/rrcompendiumDTB/raw/master/DESCRIPTION �� R 

devtools��install_deps(); devtools��install(); tinytex��install_tinytex()"

RUN rm DESCRIPTION.1; exit 0
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Add binder README  badge
holepunch��generate_badge()

launchlaunch binderbinder

● Copy and paste the following lines into '/Users/Anna/Documents/workflows/compendia/r

  [![Launch Rstudio Binder](http:��mybinder.org/badge_logo.svg)](https:��mybinder.org/

  [Copied to clipboard]
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Launched Binderised Compendium
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Reproducibility in Practice
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ReproHacks

one day reproducibility hackathons

Mission: Reproduce papers from code and data
Record experiences and feedback to authors

Available soon: Publish Reproducibility Report in ReScience C
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ReproHack Bene�ts
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1. Practical reproducibility they can
implement in their own work

Participants
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1. Practical reproducibility they can
implement in their own work

Participants
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1. Practical reproducibility they can
implement in their own work

2. Inspiration from working with other
people’s code and data.

Participants
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1. Practical reproducibility they can
implement in their own work

2. Inspiration from working with other
people’s code and data.

3. Reproduction as community value

Participants
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1. Useful feedback on the reproducibility
of their work

Authors
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1. Useful feedback on the reproducibility
of their work

2. Appreciation for their efforts in
making their work reproducible

Authors
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1. Useful feedback on the reproducibility
of their work

2. Appreciation for their efforts in
making their work reproducible

Authors
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1. Useful feedback on the reproducibility
of their work

2. Appreciation for their efforts in making
their work reproducible

3. An opportunity to engage others with
their research.

Authors
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Huge thanks to @EnviroKaty
for submitting a fab 🦋 🦋🦋
paper to the #CCMcr19
#ReproHack ! I had loads of fun
reproducing the analysis for
this really cool paper

https://t.co/v1ww2D5xhg
pic.twitter.com/r8rYMAMvPm

— Jessica Ward (@JKRWard)
June 27, 2019

Reproducing papers is fun!!
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This thing is really happening!
pic.twitter.com/d2xnHNo9z2

— ReproHack NL ♻ 
(@ReproHackNL) September
20, 2019

Upcoming ReproHacks!
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Take home
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Following conventions ➡ 
This image was created by Scriberia for The Turing Way community and is used under a CC-BY licence.
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Successful Reproducibility ➡ 

slide: Karthik Ram: rstudio::conf 2019 talk
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Enhanced Research Cycle 🔄
This image was created by Scriberia for The Turing Way community and is used under a CC-BY licence.
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Reproducibility as standard 👍
This image was created by Scriberia for The Turing Way community and is used under a CC-BY licence.
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Resources
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Book
a lightly opinionated guide to reproducible
data science

https://the-turing-way.netlify.com

workshops
Boost Your Research Reproducibility
with Binder materials

Build a binderhub materials

The Turing Way

https://github.com/alan-turing-institute/the-turing-way
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Version Control

Happy Git and GitHub for the useR

RMarkdown

R Markdown: The De�nitive guide
RMarkdown Driven Development
(RmdDD) : Blog post by Emily Riederer

R Packages

R packages  by Hadley Wickham and
Jenny Bryan

Research Compendia

Karthik Ram: rstudio::conf 2019 talk

Docker & Binder

Getting started with binder docs
rOpenSci Docker tutorial

Tutorials

Rstudio Essentials  Webinar series

rrresearch : ACCE DTP course on
Research Data & Project Management

Reproducibility in R
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ReproHacks
reprohack-hq  repository
Check out our issues

Chat to us:
chatchat on gitteron gitter

Sign up to our Newsletter

Enter your email address

Subscribe

powered by TinyLetter
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Questions?
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